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Introduction

AEM AEMLOG is a data analysis package designed to be used in
conjunction with AEMPro. AEMLOG offers many advanced analysis
features including overlays, histograms, XY plots, maths channels, lap
analysis, track drawing and channel alarms. AEMLOG runs under the
Windows 95/98 operating systems.

Documentation

This User Guide is split into two main sections. The first, Getting Started,
contains instructions on programming and reading data from the logger and a
brief overview of many of the AEMLOG features. The second section,
Reference, discusses the features of AEMLOG in detail and outlines the
methodology behind installing and calibrating sensors for use with the logger
and the use of AEM beacons for lap timing purposes.

Throughout this guide, procedures in AEMLOG are referred to using the
menu commands separated by a | symbol. Thus Fi | e | Open means select
the Open command from the File menu. If a keyboard shortcut or a button on
the AEMLOG toolbar also performs the same task, this is shown in the left
hand margin.

A comprehensive on-line help system is provided with AEMLOG to give
more details on using the package. To view the help, press F1 or select Hel p
| Help Topics.

Help can also be obtained in dialog boxes by clicking on the ? in the top right

hand corner of the box and then clicking on the item for which you require
help.
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Installing AEMLOG

AEMLOG is supplied on CD-Rom. To install AEMLOG:

o Insert the AEM cd into the disk drive.

e From the Windows Explorer,copy AEMlog from the cd to the AEMpro
folder created in the initial installation. Then copy Kl2dll32.dll into the
Windows/System folder.

e Torun AEMLog, double click on the AEMlog EXE file.
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AEMLOG Quick Reference
The following sections give a brief overview of options and menu commands

available in AEMLOG. For more information, see either the on-line help or
the Reference section later in this User Guide.

The Main Graph Screen

The following screenshot shows a typical AEMLOG graph screen with areas
of interest marked.

[if the graph is in
overlay mode, ; ; ; X
- Ciwork'DLOGI9'Data’'Demo.stf
clicking on the y
axis cycles 10000 Time: 2:01.22
[through all the 7500 M“WWW’” I Dist: 5235m
axes scales for tha 000 Engine®pd  @la?
lot LFuhaal 5pd 1955
1% 2500 Siering Pr 052
]
|Placing the mouse 250
Oera matker vl o ﬂww
show the time and | 125
date when the N o5
marker occurred o
{ ;
llows scrolling 10 ‘
through a 0.0 —MW
zoomed in graph \ 105
SN O E
2:00 230 3:00 3:50
Y l / !
J
Plotvs. Time  Rgal Values Standard [Show Plotted /| W
/
Shows current | Moving this bar changes Shows values of
|graph settings the size of the values are each channel at
and changes the font size current cursor
as necessary osition

Many of the commands in the Graph menu are reproduced in the graph popup
menu. To view this menu, right click on the graph itself.

To zoom in on the graph to view the data in more detail:

Keypad + e Select Gaph | Zoom | In. The cursor will change into a 2

showing that you are in x axes zoom mode.
e Click on the area of the graph where you want the zoom to start.
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e Click on the area of the graph where you want the zoom to end. The graph
will be redrawn with the new zoom range.

e The selected zoom range is bounded by red vertical lines at the start and
end. Using the scroll bar at the bottom of the graph, data outside this zoom
range can be viewed.

e If there is data outside the scrollable region, a [ or [ will be shown at the
edge of the scrollable area. These will shift the zoom area to the left or
right respectively.

Ctrl Keypad The y axis can be zoomed in a similar manner by selecting G aph | Zoom
+ | Expand which will change the cursor to Q to show that you are in y
axis zoom mode.
Menu Commands
The following section gives a brief overview of the menu commands and their
use. If a tool bar button or a keyboard shortcut can be used to perform the
same function, it is shown in the left hand margin.
File Menu
The File Menu contains all the commands used for file management:
F3 Open

Ctrl F3

e Use the open command to open a log file.

Reopen
e Allows a file to be selected from the most recently opened log files. The
down arrow next to the open button can also be used to reopen files.

Export
e Exports data in an ASCII format suitable for use in other applications such
as word processors or spreadsheets.

Abstract
e (Copies selected channels into a new data file.

Notes

¢ Displays notes about the current data file and allows new notes to be
added.
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F4

Ctrl E

Shift F5

&

Shift F2

Shift F4

El

Exit
¢ Quits AEMLOG.

Setup Menu

The Setup Menu contains commands for retrieving, editing and programming
logger set-ups. For more information on creating set-ups, see the Reference
section of this guide.

Create

e Creates a new default setup. This is useful when the new setup to be
created is very different from any existing set-ups.

Open
e Opens a setup file for programming into the logger.

Reopen

e Allows a recently used setup to be reopened. The arrow to the right of the
button can also be used to ReOpen files.

Extract

e Extracts the setup from the currently active data file and makes it the
currently active setup for editing and saving.

Edit
e Allows the currently active setup to be edited and saved.

¢ Buttons are also available in the setup editor for Programming and Printing
the setup.

Save
e Saves the currently active setup to disk.

Print
e Prints the currently active setup.
e Only the desired elements of the setup need be printed.

Program

e Programs the current setup into a logger. See Transferring Data to and
From the Logger earlier in this guide for more information.
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Graph Menu

The Graph Menu contains commands used for displaying and printing graphs.

Ctrl G Graph
e Invokes the graph options editor where the number of lines, overlays and
lap markers can be specified. An example screen is shown below

Sets the number
of distinct areas Graph Setup Set the channels

lotted on th o be plotted here
grzgﬁ on the ) Furnber of Plot
" One Plat 1 |Engire Spd 4/
E TWD Flot 2 |LF wWheel 5|:u:|/ 7{
- - + Thiee Click the draw
A llows overlays || Lo e 7~ e
o0 be specified Overlays Flat 3 | Lateral g J he graphs
ith the overlay / —

setup editor 1

/
Cancel | Draw/l

Overlays
e Allows the graph overlays to be set.

Setup
o Edit edits the setup of the currently active graph. (Note that this is different
from the currently active setup).
F2 e Update Log File saves any changes made to the data file.

Shift Overlays
e Allows the x axis of any overlayed Files to be moved relative to the base
graph x axis by dragging the plot. When in shift mode, the cursor will

change to a '—*. Click on the graph and drag the overlayed plots to a new
position.

Zoom

e Allows zooming in or out on the x and y axes.
e In Zooms in the x axis.

e Qut Zooms out the x axis.

e Expand Zooms in the y axis.

e Contract Zooms out the y axis.

e Normal Resets all zooms.
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Ctrl T

N

@z |&xz

Ctrl F7

Ctrl F8

Plot Types

e Time or Distance: Plots the graph against time or distance (if recorded).

¢ Real or A-D: Plot the graph using real (engineering) units or using raw 8
or 16 bit data.

e Standard Plot or Lap Plot: Allows the lap plot facility to be switched on.

Tape Measure
e Displays the Tape Measure window. This allows the difference between
two points on a graph to be measured.

Insert Marker
¢ Inserts a Custom Marker at the current position.

Analysis Menu

The Analysis Menu contains commands for examining the data in more detail
than possible via a simple graph.

Lap Times
e Use to display lap markers, split, total lap times and average lap speed.

Statistics

¢ Displays minimum, maximum and average values of channels.

e Double clicking on a minimum or maximum value will automatically zoom
the graph around that point.

Histogram
e Shows the frequency of occurrence of values in a channel as a percentage
of the current zoom range time or distance.

XY Plot
e XY plots allow one channel to be plotted against another thus allowing the
relationship between the two channels to be explored.

Templates Menu

Graph templates allow frequently used graph plots, graph types and window
positions to be saved. These can then be recalled at any time by running the
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Shift F9

F9

Ctrl F9

template from the menu or by assigning a button on the toolbar to the template
and clicking on the button

Save
e Saves the current screen layout and graph options as a template.

Run
e Prompts for a template file name and then runs the specified template.

Configure
e Configures toolbar buttons for use with saved templates.

Maths Menu

AEMLOG allows mathematical formulae to be applied to recorded data
providing for much more complex analysis. Once maths channels have been
created, the calculated data can be plotted and analysed like any other channel
and can even be used in other maths channels.

Maths functions are stored in a Maths Library. This central repository of
maths functions allows libraries to be shared between users.

Note that the maths channels reference recorded channels by the name of the
channel. Therefore, for maths channels to work consistently, an effort must be
made to ensure that channel naming is consistent over time.

Open Library
e Opens and existing maths library.

Edit Library
e Edits the currently active maths library

Recalculate

e Adds maths channels to the currently active data file using the current
maths library.

¢ Added maths channels can be displayed and analysed just like recorded
channels.

Merge
e Combines two maths libraries.

Create
e C(Creates a new maths library.

Calculate On Open
e When checked, maths channels are calculated when a data file is opened.
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Calculate On Read
e When checked, maths channels are calculated when a data file is read from
a logger.

Config Menu

Logger
e Specifies the type of logger AEMLOG is being used with. The logger type
affects certain areas of the setup editor.

Options
e Allows options such as PCMCIA slot mapping and graph colours to be set.

Tool Bars
e Some or all of the tool bars can be turned off if desired.

Close On Read

e When checked, all existing data files will be closed when a new file is read
from a card. This can be useful during a logging session that may result in
the potentially confusing situation of many windows being open at once.
Opening files will not force other windows to close. When not checked,
existing files remain open when a new file is read from a card.

Notes On Read
e When checked, the user will be prompted to enter notes about the data file
whenever a new file is read from a card.

Window Menu

Tile Vertically
e Arranges windows vertically with all windows visible if possible.

Tile Horizontally
e Arranges windows horizontally with all windows visible if possible
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F1

Cascade

e Arranges windows in a cascaded format with each window on top of the
previous one.

Minimise All

e Minimises all windows.

Arrange

e Arranges iconized windows.

Close

e Closes the active window.

The numbered list at the foot of the Window menu can be used to make the
desired window active.

Cascaded windows appear on the screen diagonally, from upper left to lower
right, overlapping so that the title bar of each window remains visible.

Tiled windows are distributed to each corner of the screen, so that each
window is visible and none overlap.

Icons (or reduced windows) appear at the bottom of the AEMLOG main

window. Each icon remains visible. Double-click an icon to make that
window active.

Help Menu

Help Topics
¢ Display the Help Topics dialog box:

About
¢ Display program version and serial number information.

To find a topic in Help:

e Click the Contents tab to browse through topics by category.

e Click the Index tab to see a list of index entries: either type the word you're
looking for or scroll through the list.

e Click the Find tab to search for words or phrases that may be contained in a
Help topic.

Context sensitive help can be obtained by pressing the F1 key.

Help can also be obtained in dialog boxes by clicking on the ? in the top right
of the dialog box and then clicking on the item for which you require help.
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The Input Table

The input allocation table provides information on the logger inputs, some of
which are user-configurable. An example of the input allocation page is
shown below.

A% CrWork' DL OGI9 Setup'Demo.stu

Inputs |5|:alars| Function Tal:ulesl Dutputsl Lights I Motes I
[rput M ame | ComCode | Type | I Code |F'u|| Llpslﬂ —CAM Speed;
Analogue 1 FCoo . CAM 1
Analogue 2 FCOZ2 -  160Hz=
Analogue 3 FCO4 & 1MH2
Analague 4 FCOB
Analogue & FCOa
Analogue B FCOA B2
Analogue 7 FCOC : " 160Hz
Analogue B FCOE . * 1MHz
Analogue 9 FC10 .y
Analogue 10 FC12 »

e The Input Name column shows the input name.

e The ComCode column displays the comcode for that input. ComCodes are
used for serial communication between AEM products and this information
is useful when creating setups for the DW97 colour display.

e The input Type shows the inputs relation to the outside world and can be
either Analogue, Serial, Speed, CAN port 1 or CAN port 2.

e The ID Code specifies a CAN arbitration code for the channel. Note that
each CAN code supports four word channels. Consequently, the first code
is used by CAN 1 to 4, the second by CAN 5 to 8 and so on. Within each
code, the first word is used by the first channel in the group and so on.

e Analogue inputs 9 to 16 have software selectable pull up resistors. Double
clicking on this column for one of these channels toggles the pull up ON (a
green tick) or OFF (a red cross).

The speed of the two CAN ports is also selected from this page.
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The Scalars Table

Scalars are used to calibrate raw data in the form y= mx + ¢, where y is the
real data, x is the raw data, m is the multiplier and c is the offset. Scalars are
combined with Inputs in the Output page to create the recorded outputs.

4%, Cwork'DLOG99 Setup'Demo.stu EHE |
Inputs  Scalars | Function T ables I Outputz I Lights I MHotes I
M ame | G ain | kA uiltiplier | Offzet | ki | T |ﬂ
Faw o a1 1 1] 1] 2585
Raw 16 16 bit 1 1] 1] ER535
RPM Serial 16 bit 1 1] 1] 10000
Thrattle Ser 16 bit 01 1] 1] 100
Lo Temp Ser 16 bit 01 -100 1] 150
Hi Temp Ser 16 bit n1 100 1] 1000
Lo Press Ser 16 bit 1 1] 1] 1100
Hi Press Ser 16 bit 0.007 1] 1] 10
Air/Fuel 16 bit 0.4z 1] 1] 20
n Senenr AR nna R4 e 2

The Name column specifies the name of the scalar

Real = Raw x Multiplier + Offset
The Min and Max values define the lower and upper limits of the y axis when

the data is plotted. See the Calibrating Sensors section for more details on
setting up the scalar and function table.
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Function Tables

Function tables are used to convert a non-linear sensor output into linear real
data and are entered into the Functions page of the setup editor. An example

function table page is shown below:

setup-pemosy g |

Inputsl Scalars i

Mame

YOO Press
Gear Fosn

Front Susp

ax16
16 it
16 it

Add
10 [...]
255 () Delete
30 [...]

The Add and Delete buttons can be used to add or delete function table

SENSors.

The Name box is used to specify the name the function table.

The Gain column specifies how the raw data is stored as discussed above.

The Min and Max values define the lower and upper limits of the y axis when

the data is plotted.

Clicking on the (...) button displays the function table editor:

[rpuit COutput ﬂ
1]
21 2
a3 4
115 k
138 a

El

|nzert Delete |

Use the Insert button to add another entry or the Delete button to delete an

entry.

The Input column contains the raw values.
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The Outputs column contains the real values.

Once the function table has been entered, click the x button to return to the
Function Table page of the editor.

Function tables calculate the real value by looking up the raw value in the
input list and matching it to an output value which is multiplied by the
multiplier. Linear interpolation between nearest sites is carried out if
necessary. See the Calibrating Sensors section for more details on setting up
the scalar and function table.
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Analysing Data

F3 Once a data file has been opened, data can be viewed and analysed by several
E means in AEMLOG, each of which will be considered in detail below.

Simple Graphs

The simple graph allows channel data to be plotted against time or distance (if
recorded). A typical graph screen is shown below:

[f the graph is in
overlay mode, C:Work'DLOGIY Data'Demo.stf

clickingonthey IFiiiimm —— =
. 10000 I Tirne: 2:01.22
axis cycles through ] ey 5
all the axes scales a0/~ WW E pIS;.pEESE;I&z
for that plot Sl P enel Sl 1555
2500 Sogring Pos -0SED
oo
Placing the mouse 250
over a marker will 183 f M R
show the time and 125
date when the 625
arker occurred 000
210
llows scrolling 105
through a 000 *‘m—th
zoomed in graph
-105 E E
-210
2:00 230 3:00 3:50
2 | 30
Plotvs. Time  Real Values Standard |Show Plotted | W
Shows current Moving this bar changes Shows values of
graph settings the size of the values are each channel at
and changes the font size current cursor
as necessary Iposition

To alter the graph settings, commands from the graph menu are used. Many of
these commands are reproduced in the graph popup menu. To view this menu,
right click on the graph itself.
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To change the lines plotted, choose Graph | Graph and the graph setup editor
will be shown:

Sets the number
of distinct areas Graph Setup ' B | |'Se; thelchal(linfl:ls
lotted on the o be plotted here
oraph Murnber of Plot
" One Plat 1 |Engine Spd j
= Two
o Plat 2 [LF wheel Spd =]
+ Three Click the draw
Allows overlays Plat 3 | Lateral g j utton to draw
to be specified Crverays
ith the overlay =
setup editor
Cancel | Drraw I

Overlays can also be added from here by clicking the overlay button.
Overlayed channels can be from either the existing file or from additional
externals files. Up to four external files can be added; when plotted, overlayed
channels from external files are preceded with a number corresponding to the
file number in the overlay list.

Overlays from external files can be shifted relative to the base graph by
selecting Graph | Shift Overlays. This allows starting points of data to be

easily synchronised.

To zoom in on the graph to view the data in more detail:

Keypad + Select G aph | Zoom | In. The cursor will change into a 9
showing that you are in x axes zoom mode.

e Click on the area of the graph where you want the zoom to start.

e Click on the area of the graph where you want the zoom to end. The graph
will be redrawn with the new zoom range.

e The selected zoom range is bounded by red vertical lines at the start and
end. Using the scroll bar at the bottom of the graph, data outside this zoom
range can be viewed.

e If there is data outside the scrollable region, a [ or [ will be shown at the
edge of the scrollable area. These will shift the zoom area to the left or
right respectively.

Keypad - e To zoom out to the previous zoom level, select Graph | Zoom | Out.

Ctrl Keypad ® The y axis can be zoomed in a similar manner by selecting Graph |

* Zoom | Expand which will change the cursor to @ to show that you

are in y axis zoom mode.
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Ctrl Keypad

e To contract the y axis to the previous lever, select Graph | Zoom |
Contract.

The right hand side of the graph shows the values at the current position
(shown on the graph by a vertical black line). This position marker can be
moved by clicking the left mouse button on the graph and dragging the bar
whilst still holding the mouse button down. Alternatively, the left and right
cursor keys can be used (holding the shift key down whilst pressing the cursor
keys will move the bar ten times as fast).

Clicking the right mouse button on the values area of the graph will show a
menu allowing line colours, style and y axis limits to be changed. This menu
can also be used to add boundary lines for highlighting ranges on the graph.

The y axis labels of the graph show the real or raw ranges of the graph. If a
particular plot has overlays, the axis limits will show the current percentage
range. By clicking on the y axis, the y axis labels will cycle through all actual
channel limits for that plot.

The functions available from the Analysis menu will now be considered.
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Statistics
F6 The statistics screen displays the minimum, maximum and average values of
| all channels in the base graph over the current zoom range and the times at

which these occur. Double clicking the mouse on the time at which a
minimum or maximum value occurs will zoom the graph in around this point.
An example statistics screen is shown below:

B Statistics - GEMSDemo._stf - Oz to 16062
Charinel Minirnum Time at Min | Masimum | Time at Max | Average |
Engirne RFM il 21.5 5750 1435 32366
Boost Prs 018 536 1.26 93.2 0.62453
‘W ater Temp 73 127 34 55 80.811
Oil Pressure 23332 21.5 41624 141.5 37393
TPS 8 18.4 a4 1247 27463
il Temp 33 135 104.5 45.5 101.25
AR 17 135.2 43 b 25,447
Batteny ¥ 1316 21.5 13.86 121 13.712
Speed Right 0 o g1.4 376 50.158
Speed Left 0 349 1056 05 4545
' aw -85.964 129 16.926 100.5 -7.9304
Distance 0 o 2563 1605 11835
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Histograms

Ctrl F7

Histogram shows the frequency of occurrence of values in a channel as a
percentage of the current zoom range time or distance. Choose Analysis |
Histogram to show the histogram setup editor:

Channel for which | [Tt | [Condition which
the histogram is to | | ~Charinel Dption must be met for a
be calculated value to be
Channel IBDDSt Pra j % ladded to the
¥ when [Engine RPM =] > Jeo0n || [rstosmm
Number of bars the | [ ﬂ[@ne RPM =] < [6000
histogram is to be
split over [nonE 7] |EngirEFrFtM\j > 1SN \ [~ dditional
N itiona
—Hiztogram O ption diti
Set whether the Murmber of Bars Iﬁ ~#Auto Ranges S
bar ranges are to = | Stan
be calculated Bar Range
. 0.2 Sets the start and
autO?vatécally or + Auta I end bar ranges if
spectiie End in auto range
manually i~ Manual IEI.E 7 mode
Cancel |

Set channel to the channel for which the histogram is to be calculated.
Conditions can then be applied to the histogram to limit the amount of data
included by checking the When box and entering the condition desired. Up to
three conditions can be specified and are combined with the logical operators
AND, OR, NOT. Only values that meet the specified criteria will be included
in the histogram. The number of bars to plot and the bar ranges can now be
specified.

Analysing Data - 21



AEMLOG User Guide

Once the setup is complete, click OK and the histogram will be drawn:

Histogram - GEMSDemo._stf - Oz to 160.6s [_ [O] x|

oo I w 3

o3 - -

1]
02 026 032 038 044 05 0B 062 0EBE 074 08
Boozt Prz with Engine BPR > 4000 AMD Engine BPR < G000

Once a histogram is drawn, the histogram editor can be re-entered by right
clicking on the histogram. Once a histogram setup has been created it can be
saved to a histogram template by clicking the Save button in the histogram
editor. Histogram templates can be assigned to buttons in the histogram editor
by selecting Config | Options and entering the filename in the histogram
buttons page.
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XY Plots

Ctrl F8

XY plots allow one channel to be plotted against another thus allowing the
relationship between the two channels to be explored. To create an XY plot,

choose Analysis | XY Plot; the XY plot editor will be shown:

Channels to be
used for the X
and Y axes

Channel
conditions

Sets the size of
the plotted
points.

Y Options H
Chagnel Option

* Emil Engine RPM

YChannel |5peed Right j

r 5 S |EI

[nONE|Eraine RPM B> D

Puaint Size IE :}

Cancel | k.

Set the X and Y channels for which the XY plot is to be draw. Conditions can
then be applied to the plot to limit the amount of data included by checking
the When box and entering the condition desired. Up to two conditions can be
specified and are combined with the logical operators AND, OR, NOT. Only
values that meet the specified criteria will be included in the XY plot.

The point size changes the size of the plotted points. On plots using a large
amount of data, a small point size should be used. However, when the data set
used is small, a larger point size helps to show any trends in the data
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Once the setup is complete, click OK and the XY plot will be drawn:
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By clicking and holding the left mouse button on the graph, the mouse can
move the cross hairs on the plot. The X and Y values at the current cross hair
position are shown in the status bar at the foot of the graph.

Once an XY plot is drawn, the XY plot editor can be re-entered by right
clicking on the plot. XY plot settings can be saved in an XY plot template by
clicking the Save button in the editor. XY templates can be assigned to
buttons in the editor by selecting Config | Options and entering the filename
in the XY plot buttons page.

Analysing Data - 24



AEMLOG User Guide

Maths Channels

Shift F9

AEMLOG allows mathematical formulae to be applied to recorded data
providing for much more complex analysis. Once maths channels have been
created, the calculated data can be plotted and analysed like any other channel
and can even be used in other maths channels.

Maths functions are stored in a Maths Library. This central repository of
maths functions allows libraries to be shared between users.

Note that the maths channels reference recorded channels by the name of the

channel. Therefore, for maths channels to work consistently, an effort must be
made to ensure that channel naming is consistent over time.

Defining Maths Equations

To show the maths library editor, either open a maths library using Maths |
Open Library (Shift F9) or edit the currently active maths library using
Maths | Edit Library (F9). Note that AEMLOG always sets the last opened
maths library as the currently active maths library. The currently active maths
library is shown in the AEMLOG status bar.

The main page in the maths library shows the maths equations currently
created. The Name column shows the name of each equation and the
equation column shows the actual equation. To create a new maths equation,
click the Add button and enter a name for the equation. By clicking on the
(...) button next to the equation, the equation editor is invoked.

The equation editor allows the maths equation to be entered/edited. A typical
equation editor window is shown below:
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¢ The equation will appear as it is entered in the top left edit window.

¢ To add an output to the equation, ensure Outputs is selected in the Object
box, then click on the desired channel from the list displayed.

¢ To add numbers, +, -, /, * or brackets, simply type in using the keyboard or
use the mouse with the keypad displayed to the right of the Maths Editor.
Note: no operators have precedence in the Maths Editor: i.e. 1+2%*3 will
evaluate as 3*3. Use brackets to change the evaluation order: i.e. 1+(2*3)
will evaluate as 7.

¢ To add a maths function, ensure Functions is selected in the object box, then
click on the desired function.

¢ [f Auto Range is checked, values for the Minimum and Maximum range
will be automatically calculated.

o [f Auto Range is not checked, values for Minimum and Maximum cane be
entered. The Min and Max values
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F9

Adding Maths Channels

To calculate maths channels for the currently active data file, choose Maths |
ReCalculate or press Ctrl F9. A window will appear showing the progress of
the maths calculation. Calculation can be stopped at any point by pressing the
Cancel button. Once the maths channels have been added, they can be plotted
and analysed like any other channels.

The maths evaluator automatically adds any channels in the currently active
maths library that have their required channels recorded. Any maths channels
that do not have the required outputs recorded are not added. The record rate
for the maths channels is determined automatically from the rates of the
recorded data.

Note that the maths library matches channels by name...channel naming must
remain consistent over a period of time for the maths library to remain
universal.

AEMLOG can also be configured to automatically calculate maths channels:
o If Maths | Calculate On Open is checked, AEMLOG will attempt to
calculate the maths channels whenever a file is opened.

o [f Maths | Calculate On Read is checked, AEMLOG will attempt to calculate the maths
channels whenever a file is read
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